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A tool that isn't perfect but can be helpful. Some issues need to be fixed.Reactive and great customer service.Date of experience: July 15, 2025Simple to use & practical. Customer service responses clear and fast.Date of experience: July 17, 2025¢great tool, very helpfulDate of experience: July 19, 2025Very good so easy OsadharonDate of experience:
July 19, 2025PDF Guru has excellent customer service! Each time I've contacted them for support, they have responded quickly and I've been thrilled with the outcomes. Date of experience: July 18, 2025Amazing service and highly recommended Date of experience: July 18, 2025Was easy to download and upload files that need a change on
formatDate of experience: July 18, 2025Your service is just super, thank you. AnnaDate of experience: July 18, 2025Please, Dont send me bills any moreDate of experience: May 30, 2025Very bad experience, no product delivered, credited my creditcard and the only response was non refundable! Terrible terribly customer supportDate of experience:
July 18, 2025PDF GURU, Stop trying to steal money from my account, because I already know that you have this reputation of wanting to take 49.99 from the account of everyone who accesses your platform, or we will get very farDate of experience: July 10, 2025My experience was excellent. The program includes many features and saves activity in
the subscriber's account for reference. The program allows for online work, and the procedures are easy and intuitive.Date of experience: July 18, 20251 signed up for 1 weeks use. I paid 1.99. At no point did I agree to any further payments. 7 days later, they took a payment of 49.99 and refused to refund it. I have explained that I need the money.
They have refused to refund this despite me not agreeing to any payment being taken. I have taken the same steps to sign up to check for subscription information but it is nowhere to be seen. It seems people in other countries have been given refunds for similar but not people in GB! Date of experience: July 10, 20251 have also been scammed by
being tricked into subscribing for a year without my knowledge. My bank have just informed me that this company attempted to take a further 2 lots of 49.99 so that is almost 150 they have tried to steal from meDate of experience: July 18, 2025This company is clearly a fraud, they use bad practices to get payment data and then charge not approved
subscriptions which are an absolute nightmare to get rid of. The product is just OK and not offering anything many other products couldnt offer, their efforts are in SEO and trapping non voluntary customers into recurrent payments that are almost impossible to get reimbursed. Date of experience: July 18, 2025Fast and easy to use! Date of
experience: July 18, 2025this company is trying to cheat money for every transaction you pay online, I bought the subscription, when I was paying, they tried to add another transaction making me pay more. The same kind of tricks happened twice and the second time the amount is 50 times higher than the first time. It is so scary to deal with this
companyDate of experience: July 17, 2025i AM PRESSED FOR TIME AND ALL THE UP-SALES TAKE TOO LONG TO GET PASS.Date of experience: July 18, 2025Great job. Thank you for your help!Date of experience: July 18, 2025When I had a problem the contact was immediate and efficient. The problem solved without any delay.Date of experience:
July 16, 2025Simple Online Tool to Combine PDFsWith our Merge PDF tool, combining multiple files into one document is quick and effortless. Simply upload your PDFs, and our tool takes care of the rest. Its free to use, with no hidden steps, and no registration needed.Secure Online PDF MergingYour files are secure with us. Your uploaded files are
encrypted using TLS, and theyre automatically deleted from our servers after one hour. For more details, check out our privacy policy.Works on Any DeviceMerge multiple PDFs easily right from your web browserno downloads or installations required. Combine PDF documents seamlessly on Mac, Windows, Linux, or mobile. Prefer offline? Use our
Windows app on your computer for fast and efficient merging anytime.Preview and Organize with ThumbnailsUpload your PDFs, and well show you a preview. Rearrange PDF pages into the desired order, delete what you dont need, or add more files before merging. Its quick, simple, and fully customizable to suit your needs.Reliable PDF MergingSay
goodbye to expensive softwareour PDF merger is free, simple, and secure. Your file is protected with industry-standard TLS encryption, so you can merge PDFs into a single file confidently, knowing your data stays safe and private.Cloud-Based ProcessingOur online PDF merger is cloud-based, saving your devices resources and giving you the
freedom to merge PDFs from anywhere, anytime. Download Article Learn free and easy ways to merge PDF files online or on your computer. Download Article Combining the contents of two or more PDF files is easy, even if you don't have Adobe Acrobat. Many free apps are capable of merging PDF files together. You can do it online using a wide
variety of tools, including Adobes free PDF Combiner. You can also do it on your desktop PC with a free third-party app like PDF Merger & Splitter, or with built-in tools like Finder and Preview on Mac. This tutorial will teach you quick and easy ways to merge several PDF files into a single document. 1 2Drag and drop the files you want to merge.
Locate the PDF files you want to combine on your computer, then drag and drop them into the PDF Combiner window. Place the files in the area where you see the message Drag and drop PDFs to merge them into one file with our PDF combiner.You can also click the blue Select files button. A File Explorer (Windows) or Finder (Mac) window will
open where you can browse for and select the PDFs you want to merge. Advertisement 3Reorder the files if you want. If you want to change the order of the different PDFs within the merged document, simply click and drag them to your preferred order in the window. You can also add or remove PDF files from the list.To remove a file, hover over it
and then click the trash can icon.To add more files, click the icon at the top of the merger window that looks like a document with a + in the bottom right corner.4Click Merge. Youll see this blue button at the top right corner of the PDF Combiner window.5Click Download. Once the files are finished processing, this button will appear on the left side
of the page. By default, the merged file will save to your Downloads folder. Advertisement 1Download PDF Merger & Splitter. PDF Merger & Splitter is a free app that allows you to merge PDFs and extract pages from a PDF. You can download PDF Merger & Splitter for free from the Microsoft Store.[1] Use the following steps to download PDF
Merger & Splitter:Click the Windows Start menu.Click the Microsoft Store icon, which resembles a white shopping bag.Click Search in the upper-right corner.Type "PDF Merger & Splitter" in the search bar.Click PDF Merger & Splitter.Click GET.There are lots of similar apps available, and they all work similarly. Other free options include PDFsam
Basic, Merge PDF Free, and Merge PDF PLUS.20pen PDF Merger & Splitter. PDF Merger & Splitter has an icon that resembles a page. You can find it in the Windows Start menu, or you can click Launch in the Microsoft Store once it finishes downloading.3Click Merge PDF. It's the first purple button in the center of the page.4Click Add PDFs. It's
the first option in the upper-left corner. This option opens File Explorer and allows you to browse for PDFs.5Navigate to the location of the PDFs you want to merge. Use File Explorer to navigate to the location of the PDFs you want to merge. Double-click the folder the PDFs are located in to navigate to that folder.6Select the PDFs and click Open.
You can select more than one file at a time by holding the Ctrl button and clicking the files you want to open. Then click Open in the lower-right corner.Click Add PDFs again to upload additional PDF files.To change the order of the PDFs, click the PDF file you want to move in the list, and click Move Up or Move Down above the list.To remove a PDF,
click the PDF you want to remove and click Remove above the list.7Click Merge PDFs. It's in the lower-right corner. This displays a Save prompt that you can use to save the merged PDFs.8Type a name for the merged PDF. Use the field next to "Filename" to type a name for the merged PDF.You can also select a location to save the file to.9Click Save.
This saves your PDFs as a single, merged PDF. Advertisement 10pen a Finder window. Click the Finder icon in the Dock to open a new Finder window. Navigate to the location of the PDF files you want to merge.2Click the Gallery tab. At the top of the Finder window, click the tab that looks like a rectangle with a row of squares underneath. This will
switch you to Gallery view.You can also click View in the menu bar at the top of your screen, then select as Gallery.3Command-click the PDFs you want to merge. Hold down the command key while clicking on any PDF files you want to combine. Select the files in the order in which you want them to appear in the merged PDF.4Click Create PDF. Once
youve selected two or more PDF files, a button will appear in the right panel that says Create PDF. Click this button to merge your files. The new PDF will be saved to your Desktop.You can also select the files you want to merge in List view, then control-click them and select Quick Actions > Create PDF. Advertisement 1Launch the Preview app. The
icon looks like a snapshot of a landscape with a magnifier in front of it.20pen the PDF files you want to merge. In Preview, click the File menu, then select Open. Navigate to the location of your PDF files and open them.You can select multiple files at once by command-clicking them, then clicking Open.You can also navigate to the PDF files you want
to open in Finder, then right-click or control-click them and select Open With > Preview.3Duplicate the PDFs. To avoid making any unwanted permanent changes to the original files when you use this method, you may want to make copies instead of working with the originals. To do this, select each file, then click the File menu at the top of the
screen and select Duplicate.4Open one of the duplicate files. It doesnt matter which one you start with, since you can rearrange order of the pages within the combined file.5Enable the thumbnail pane in the View menu. If you dont already see the sidebar that shows thumbnails of all the pages in your PDF, click View > Thumbnails in the menu at the
top of the screen. It will appear on the left side of the PDF window.6Drag additional PDFs into the sidebar. Click any of the other PDF files you want to merge with the first one and simply drag and drop them into the thumbnail bar on the left side of the window. Click and drag thumbnails to change the order of the pages.Want to merge individual
pages from another PDF into your document? Simply open the other PDF in preview, make sure Thumbnails is enabled, and drag the thumbnails of the desired pages over to the sidebar on the first document. Advertisement 10pen Adobe Acrobat. Adobe Acrobat has a red and white icon with a red looping swoosh in the middle. Adobe Acrobat is
Adobe's proprietary (paid) PDF creation and editing tool. Youll need to use one of the paid versions of Adobe Acrobat (rather than the free Adobe Acrobat Reader app) to merge PDFs.Adobe Acrobat is subscription-based, but Acrobat Pro offers a free trial option.2Click Tools. It's the second tab at the top. This displays the PDF creation tools.[2]3Click
Combine Files. It's the second option on the Tools page. It has a purple icon that resembles two pages.4Click Add Files. It's the blue button in the center of the pages. This opens File Explorer on Windows, or the Finder on Mac.[3]5Navigate to the location the PDFs are stored. Use the File Explorer or Finder window to navigate to the folder the PDFs
you want to merge are saved to.6Select the PDFs you want to merge. To select multiple files, press and hold Ctrl on Windows or Command on Mac. Then click the files you want to add.7Click Open. It's in the lower-right corner. This displays all the PDFs as thumbnail images in Adobe Acrobat.To add additional PDFs, click Add Files at the top of the
screen.Click and drag the thumbnail images in Adobe Acrobat to change the order of the files.To remove a PDF, click a thumbnail to select it and click Remove at the top of the page.8Click Combine. It's the blue button at the top of the page. This combines all the PDFs in the thumbnail list into one PDF.[4]9Click File. It's in the menu bar at the top of
Adobe Acrobat.10Click Save as. It's in the drop-down menu below "File" in Adobe Acrobat.11Click a recent save location or click Choose a different folder. You can select one of the recent save locations listed, or click the blue button that says Choose a different folder to select a different save location.12Type a name for the merged PDF. Use the field
next to "Filename" to type a name for the PDF.13Click Save. It's in the lower-right corner of the Save window. This saves the merged PDF using the file name you choose.[5] Advertisement Add New Question Question How can I combine PDF files together? Do I use a specific software? Luigi Oppido Computer & Tech SpecialistLuigi Oppido is the
Owner and Operator of Pleasure Point Computers in Santa Cruz, California. Luigi has over 25 years of experience in general computer repair, data recovery, virus removal, and upgrades. He is also the host of the Computer Man Show! broadcasted on KSQD covering central California for over two years. There are many free sites that you can use
online to merge PDFs. CutePDF is a good one. Question What do I do if my preview doesn't have a "save as" option, only a "save" option? Use the edit menu discussed above. Edit, Insert works. Question When I highlight several separate single-page PDFs in order to drag them to combine into a single PDF, the order changes. How can I combine
several single-page PDFs and maintain the order when I merge them? If you're using Adobe Acrobat, you can reorder the files within the "Combine Files" window by highlighting and dragging them to the order you want. See more answers Ask a Question Advertisement Co-authored by: Computer & Tech Specialist This article was co-authored by
Luigi Oppido and by wikiHow staff writer, Megaera Lorenz, PhD. Luigi Oppido is the Owner and Operator of Pleasure Point Computers in Santa Cruz, California. Luigi has over 25 years of experience in general computer repair, data recovery, virus removal, and upgrades. He is also the host of the Computer Man Show! broadcasted on KSQD covering
central California for over two years. This article has been viewed 7,972,281 times. Co-authors: 98 Updated: March 12, 2025 Views:7,972,281 Categories: Editing PDF Documents PrintSend fan mail to authors Thanks to all authors for creating a page that has been read 7,972,281 times. "Listing trustworthy PDF merge websites. FoxUtils also provide
a link to a downloadable app from Essex software, but the monthly rental for that was excessive. I was happy to donate $5 as a thank you for a quick and easy solution that I might need in future."..." more Share your story Date of experience: July 19, 2025Hello Nick,Thank you for your kind feedback! Were glad to hear you received fast assistance. If
you ever need more help or have questions, feel free to reach out anytime.Best,James, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569This website is very efficient and exceeded my expectations. It helped me solve my needs quickly and easily. Highly recommended!Date of experience: July 18, 2025Hello Yareimys,Thank you so much for your
wonderful feedback! Were delighted to hear that our service exceeded your expectations and helped you quickly and easily. If you ever need any assistance or have questions, please dont hesitate to reach out.Best,James, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569Pdfaid helped me editing the right document but went thru some
technical issues. Special agent Mr. Rick was appointed to me, he assisted me very professionally and was available to support me when i simply txted hi. It was a big time help I am thankful for that. Date of experience: July 18, 2025Hello Brinda, Thank you so much for sharing your experience! We're glad to hear that Mr. Rick was able to assist you
professionally and was there when you needed support. It's great to know the issue was resolved and that you were able to edit the right document successfully. If you ever need help again, feel free to reach outwere always here for you. Best,James, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569Date of experience: July 18, 2025Hello, Thank
you for your feedback! We're happy to hear you found our service great, quick, and efficient. We're always here if you need anything else.Best regards,James, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569Much you chat so simply Date of experience: July 18, 2025Hello,Thank you for your feedback! We're glad you found our communication
clear and simplethat's exactly what we aim for.Best regards,James, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569Assistance was really helpful. Date of experience: July 18, 2025Hello, Laiba!Thank you for your feedback! We're glad to hear the assistance you received was helpful. We're always here if you need any further support.Best
regards,James, PDFAid Supportsupport@pdfaid.com or +44 808 501 2541Nice , Quick Date of experience: July 18, 2025Hello,Thank you for your feedback! We're glad to hear you had a nice and quick experience with our service. Let us know if you need anything else!Best regards,James, PDFAid Supportsupport@pdfaid.com or +44 808 501 2541The
service was easy to use and the agent wasvery nice.Date of experience: July 18, 2025Hello,Thank you for your feedback! We're glad to hear you found our service easy to use and had a positive experience with our support team. We're here if you ever need anything else.Best regards,James, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569The
customer service representative was prompt and accurate in their replies.Date of experience: July 18, 2025Hello,Thank you for your feedback! We're glad to hear our team provided prompt and accurate support. We're always here to assist whenever you need us.Best regards,James, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569very
nice,good quality services, direct on point no additional questions Date of experience: July 18, 2025Hello, Filip!Thank you for your feedback! We're thrilled to hear you had a great experience with our servicestraightforward and high quality is exactly what we aim for.Best regards,James, PDFAid Supportsupport@pdfaid.com or +44 808 501
2541NEVER INTERACT WITH THIS COMPANYDate of experience: July 18, 2025Hello Wesley, Thank you for sharing your feedback. We're sorry to hear that your experience was not a positive one. If there's anything still unresolved or if you'd like to share more about what happened, please feel free to contact us at billing@pdfaid.com or +1 888 857
5569. Were here to listen and assist in any way we can. Best,David, PDFAid Billing Supportbilling@pdfaid.com or +1 888 857 5569Quick response, and a fast solution. Verry good job . Date of experience: July 18, 2025Hello, Armin!Thank you for your feedback! We're happy to hear you received a quick response and a fast solution. It's great to know
you were satisfied with the support.Best regards,James, PDFAid Supportsupport@pdfaid.com or +44 808 501 2541Efficient services that are straight forward.simplified payment method.Date of experience: July 18, 2025Hello, Ibrahim!Thank you for your feedback! We're glad to hear you found our services efficient and straightforward, and that the
simplified payment method worked well for you.Best regards,James, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569Resolved my issue in a very timely manner Date of experience: July 18, 2025Hello, Melissa!Thank you for your feedback! We're glad to hear your issue was resolved promptly. It's always our goal to provide fast and reliable
support.Best regards,James, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569My small business relies on PDFAid for contracts. I can sign documents online and send them immediately. The online pdf service keeps my workflow moving efficiently every day.Date of experience: June 04, 2025Hello Amir, Thank you so much for your great
feedback! Were happy to hear that PDFAid is helping keep your small business running smoothly, especially when it comes to signing and sending contracts quickly. If you ever need assistance or have any questions, feel free to reach outwere always here to support you. Best,David, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569Nice .
Problem really quick solved Date of experience: July 18, 2025Hello, Lena!Thank you for your feedback! We're glad to hear your issue was resolved quickly and that you had a positive experience with our service.Best regards,James, PDFAid Supportsupport@pdfaid.com or +44 808 501 2541Help came quickly. Everything was top notch. 10/10.Date of
experience: July 18, 2025Hello Romanas, Thank you so much for your fantastic feedback! We're thrilled to hear that everything went smoothly and that you were happy with the support. If you ever need assistance again, dont hesitate to reach outwere always here for you. Best,David, PDFAid Supportsupport@pdfaid.com or +44 808 501 2541Quick
and qualified response. Thank you! Date of experience: July 18, 2025Hello,Thank you for your feedback! We're glad you received a quick and qualified responsethats exactly what we aim for. Feel free to reach out anytime you need assistance.Best regards,James, PDFAid Supportsupport@pdfaid.com or +44 808 501 2541The assistant answered me on
time and effectively soDate of experience: July 18, 2025Hello Lerato, Thank you for your kind feedback! Were glad to know the assistant was both timely and effective in helping you. If you ever have more questions or need further support, feel free to reach out anytime. Best,David, PDFAid Supportsupport@pdfaid.com or +1 888 857 5569Great agent
work, helped me a lotDate of experience: July 18, 2025Hello,Thank you for your feedback! We're glad to hear that our team was able to help you effectively. We're always here if you need further assistance.Best regards,James, PDFAid Supportsupport@pdfaid.com or +44 808 501 2541
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